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The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). It has 14 digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a USB connection, a power jack, an ICSP header, and a reset button. It contains everything needed to  support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI USB-to-serialdriverchip.Instead,itfeaturestheAtmega8U2programmedasaUSB-to-serialconverter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
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will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB Arduinoboards,andthereferencemodelfortheArduinoplatform;foracomparisonwithpreviousversions, see the index of Arduinoboards.
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EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf
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Microcontroller
ATmega328

OperatingVoltage
5V Input Voltage (recommended) 7-12V InputVoltage(limits)
6-20V

DigitalI/OPins
14 (of which 6 provide PWMoutput)

AnalogInputPins
6

DC Current perI/OPin
40 mA DC Current for3.3VPin
50 mA

FlashMemory
32 KB of which 0.5 KBusedby bootloader

SRAM
2KB

EEPROM
1KB
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ClockSpeed
16MHz
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ledPin = 13;  // LED comnected to digital pin 13
// The setup() method runs once, when the sketch starts

0ot
/7 initialize the digital pin as an output:
(Leapin, 0UTPUT);

77 the loop(] method runs over and over again,
77 as long as the Arduino has pover

0

(LedPin, HIGH): set the LED on
(1000} wait for a second

(Ledpin, L0W); set the LED off
(1000} wait for a second
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The Arduino Uno can be powered via the USB connection or with an external power supply. The power source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage regulator may overheat and damage the board. The recommended range is 7 to 12 volts.

The power pins are as follows:

· VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 5 volts from the USB connection or other regulated power source). You can supply voltage through thispin,or,ifsupplyingvoltageviathepowerjack,accessitthroughthispin.

· 5V. The regulated power supply used to power the microcontroller and other components on the board. This can come either from VIN via an on-board regulator, or be supplied by USB or another regulated 5Vsupply.

· 3V3.A3.3voltsupplygeneratedbytheon-boardregulator.Maximumcurrentdrawis50mA.
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GND. Groundpins.
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The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and has an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have specialized functions:

· Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are connectedtothecorrespondingpinsoftheATmega8U2USB-to-TTLSerialchip.

· External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a risingorfallingedge,orachangeinvalue.SeetheattachInterrupt()functionfordetails.

· PWM:3,5,6,9,10,and11. Provide8-bitPWMoutputwiththeanalogWrite()function.

· SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, althoughprovidedbytheunderlyinghardware,isnotcurrentlyincludedintheArduinolanguage.

· LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is on, when the pin is LOW, it'soff.

[image: image25.png]Linux Install





The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By default they measure from ground to 5 volts, though is it possible to change the upper end of their range using the AREF pin and the analogReference() function. Additionally, some pins have specialized functionality:

· I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wirelibrary.

There are a couple of other pins on the board:

· AREF. Reference voltage for the analog inputs. Used withanalogReference().

· Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to shields which block the one on theboard.
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See also the mapping between Arduino pins and Atmega328 ports.

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to- serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins.
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The ATmega328 also support I2C (TWI) and SPI communication. The Arduino software includes a Wire library to simplify use of the I2C bus; see the documentationfor details. To use the SPI communication, please see the ATmega328 datasheet.

The Arduino Uno can be programmed with the Arduino software (download). Select "Arduino Uno w/ ATmega328" from the Tools > Board menu (according to the microcontroller on your board). For details,  see the referenceandtutorials.

The ATmega328 on the Arduino Uno comes preburned with a bootloaderthat allows you to upload new code to it without the use of an external hardware programmer. It communicates using the original STK500 protocol (reference, C header files).

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial Programming) header; see these instructions for details.
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The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader, which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac  OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer (overwriting the DFUbootloader).
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Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a way that allows it to be reset by software running on a connected computer. One of the hardware flow control lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega328 via a 100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR  can be well-coordinated with the start of theupload.

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or so, the bootloader is running on the Uno. While it is programmed to ignore malformed data (i.e. anything besides an upload of new code), it will intercept the first few bytes of data sent to the board after a connection is opened. If a sketch running on the board receives one-time configuration or other data when it first starts, make sure that the software with which it communicates waits a second after opening the connection and before sending thisdata.
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The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details.
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The Arduino Uno has a resettable polyfuse that protects your computer's USB ports from shorts and overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer ofprotection.Ifmorethan500mAisappliedtotheUSBport,thefusewillautomaticallybreaktheconnection until the short or overload isremoved.
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The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple of the 100 mil spacing of the other pins.
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Arduino can sense the environment by receiving input from a variety of sensors and can affect its surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is programmed using the Arduino programming language(based on Wiring) and the Arduino development environment (based on Processing). Arduino projects can be stand-alone or they can communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal OS. Check on the Arduino site for the latest instructions. http://arduino.cc/en/Guide/HomePage
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Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.
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Now you’re actually ready to “burn” your first program on the arduino board. To select “blink led”, the physical translation of the well known programming “hello world”, select

File>Sketchbook> Arduino-0017>Examples> Digital>Blink

Once you have your skecth you’ll see something very close to the screenshot on the right.

In Tools>Board select Now you have to go to

Tools>SerialPort

and select the right serial port, the one arduino is attached to.
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1. Warranties

1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing, orforanyproductsthathavebeenalteredormodifiedinanywaybyaCustomer.Moreover,Theproducershallnotbeliableforanydefectsthatresultfrom Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems necessary.

1.2 If any products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the producershallhaveareasonabletimetoreplacements.Replacedproductsshallbewarrantedforanewfullwarrantyperiod.

1.3 EXCEPTASSETFORTHABOVE,PRODUCTSAREPROVIDED"ASIS"AND"WITHALLFAULTS."THEPRODUCERDISCLAIMS ALLOTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITYORFITNESSFORAPARTICULARPURPOSE

1.4 Customeragreesthatpriortousinganysystemsthatincludetheproducerproducts,Customerwilltestsuchsystemsandthefunctionalityofthe products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth above,andnoadditionalobligationsorliabilitiesshallarisefromtheproducerprovidingsuchservices.

1.5 The Arduinoproducts are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the operation of nuclear facilities and weapons systems. Arduinoproducts are neither designed nor intended for use in military or aerospace applications or environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduinoproducts which is solely attheCustomer'srisk,andthatCustomerissolelyresponsibleforcompliancewithalllegalandregulatoryrequirementsinconnectionwithsuchuse.

1.6 Customeracknowledgesandagreesthatitissolelyresponsibleforcompliancewithalllegal,regulatoryandsafety-relatedrequirementsconcerningits products and any use of Arduinoproducts in Customer's applications, notwithstanding any applications-related information or support that may be provided by theproducer.

2. Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages, liabilitiesandexpensesitincurstotheextentdirectlycausedby:(i)anactualbreachbyaCustomeroftherepresentationandwarrantiesmadeunderthis termsandconditionsor(ii)thegrossnegligenceorwillfulmisconductbytheCustomer.

3. Consequential DamagesWaiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the possibility of such damages. This section will survive the termination of the warranty period.

4. Changes tospecifications
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The producer may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is subject to change without notice. Do not finalize a design with this information.
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The producer of Arduinohas joined the Impatto Zero® policy of LifeGate.it. For each Arduino board produced is created / looked after half squared Km of Costa Rica’s forest’s
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Overview
HC‐05 module is an easy to use Bluetooth SPP (Serial Port Protocol) module,
designed for transparent wireless serial connection setup.
Serial port Bluetooth module is fully qualified Bluetooth V2.0+EDR (Enhanced Data Rate) 3Mbps Modulation with complete 2.4GHz radio transceiver and baseband. It uses CSR Bluecore 04‐External single chip Bluetooth system with CMOS technology and with AFH (Adaptive Frequency Hopping Feature). Ithasthe
footprint as small as 12.7mmx27mm. Hope it will simplify your overall design/development cycle.
www.electronica60norte.com

HYPERLINK "mailto:electronica60norte@hotmail.com" \helectronica60norte@hotmail.com
Specifications
Hardware features
· Typical ‐80dBmsensitivity.
· Up to +4dBm RF transmitpower.
· Low Power 1.8V Operation, 3.3 to 5 VI/O.
· PIOcontrol.
· UART interface with programmable baudrate.
· With integratedantenna.
· With edgeconnector.
Software features
· Slave default Baud rate: 9600, Data bits:8, Stop bit:1,Parity:Noparity.
· PIO9 and PIO8 can be connected to red and blue led separately. When master and slave are paired, red and blue led blinks 1time/2s in interval, while disconnected only blue led blinks2times/s.
· Auto‐connect to the last device on power asdefault.
· Permit pairing device to connect asdefault.
· Auto‐pairing PINCODE:”1234” asdefault.
· Auto‐reconnect in 30 min when disconnected as a result of beyondthe
range of connection.
www.electronica60norte.com

HYPERLINK "mailto:electronica60norte@hotmail.com" \helectronica60norte@hotmail.com
Pin out configuration
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Typical Application Circuit
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www.electronica60norte.com

HYPERLINK "mailto:electronica60norte@hotmail.com" \helectronica60norte@hotmail.com
After connect the Bluetooth module, scan for new devices from the PC and you will find the module with the device name “HC‐05”, after that, click to connect, if some message appears asking about “Pairing code” just put “1234” as default code.
BLUE LED = ACTIVE (Blinking 500ms period inactive connection, change 1seg with active connection)
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Open a serial terminal and select the serial COM x port number that assigned Windows to Bluetooth Module.
Configure the serial terminal with these parameters:
· Baud rate:9600.
· Databits:8.
· Stopbit:1.
· Parity: Noparity.
www.electronica60norte.com

HYPERLINK "mailto:electronica60norte@hotmail.com" \helectronica60norte@hotmail.com
Open connection and you will be ready to send and receive data from module Bluetooth like Serial Port COM

AT COMMANDS
How to get to AT COMMAND mode
1: Connect KEY pin to VCC.
2: Supply power to module. Then the module will enter into AT MODE. In this mode you have to use baud rate at 38400. In this way, user should change the baud rate for SLAVE AND MASTER mode.
How to set this module as “Master‐Host” role
1: Input high level to KEY.
2: Supply power to the module. And the module will enter to AT COMMAND. 3: Set the parameters of the hyper terminal or the other serial tools (baud rate: 38400, data bit:8, stop bit:1, no parity bit, no Flow Control).
4: Sent the characters “AT+ROLE=1\r\n” through serial, then receive the characters “OK\r\n”. Here, “\r\n” is the CRLF.
5: Sent the characters “AT+CMODE=1\r\n” through serial, then receive the characters “OK\r\n”. Here, “\r\n” is the CRLF.
6: Default factory password passkey is: 1243, this must be the same in the Bluetooth slave module if you want to pair it.
To read passkey use this command: “AT+PSWD?”.
To Reset the password command sent the characters “AT+PSWD=XXXX”. The password must be 4‐bits.
7: Leave free KEY, and supply power to the module again. Then this module will become master role and search the other module (slave role) automatically to build the connection (baud rate:9600, data bit:8, stop bit:1, no parity bit, no Flow Control).
How to set this module be the “Slave‐Device” role
1: Input high level to KEY.
2: Supply power to the module. And the module will enter to AT COMMAND. 3: Set the parameters of the super terminal or the other serial tools (baud rate:
38400, data bit:8, stop bit:1, no parity bit, no Flow Control).
4: Sent the characters “AT+ROLE=0\r\n” through serial, then receive the characters “OK\r\n”. Here, “\r\n” is the CRLF.
5: Sent the characters “AT+CMODE=0\r\n” through serial, then receive the characters “OK\r\n”. Here, “\r\n” is the CRLF.
6: Default factory password passkey is: 1243, this must be the same in the Bluetooth master module if you want to pair it.
To read passkey sent the characters “AT+PSWD?”.
To Reset the password command sent the characters “AT+PSWD=XXXX”. The password must be 4‐bits.
7: Leave free KEY, and supply power to the module again. Then this module will become slave role and wait to be discover it by the other module (master role) automatically to build the connection (baud rate:38400, data bit:8, stop bit:1, no parity bit, no Flow Control).
How to get to the standard communication mode
1: Leave free KEY, don’t connect it to VDD neither GND.
2: Supply power to the module. Then the module will enter to communication mode. It can be used for pairing.
(1) Notes
(2) HC‐05’s command should end up with “\r\n”. It means when you finish programming, you should add terminator (“ENTER” or “0x0d 0x0a”) to the program.
(3) The most common commands for HC‐05 are: AT+ROLE (setmaster–slave), AT+CMODE( set address pairing) , AT+PSWD (setpassword).
If you want the master module has the function of remembering slave module,the most simply way is: First, set AT+CMODE=1. Make the master module pair with the slave module. Second, set AT+CMODE=0. Then the master module just can make pair with that specified slave module. www.electronica60norte.com
electronica60norte@hotmail.com

LISTING PROGRAM
1. Program MikrokontrolerMenggunakanArduino IDE

#include <SoftwareSerial.h>

#include <string.h>

SoftwareSerialSim900Serial(2, 3);

byte buffer[64]; // buffer array for data recieve over serial port

int count=0;     // counter for buffer array

#define phonenumber "+6289503554105"  //Change to your phonenumber, the phonenumber should be the same as the format received by the SMS, may include your country code.

intdeteksi=0;

constintpingPin_Tx=9;

constintpingPin_Rx=10;

constintselenoid=6;

constint alarm=7;

constintpin_sensor =A0;
constintkunci=11;

voidalarm_aktiv(){

digitalWrite(alarm, HIGH);
}

#include <MeetAndroid.h>// declare MeetAndroid so that you can call functions with it

MeetAndroidmeetAndroid;
int data;

voida_receive(byte flag, byte numOfValues)

{

//  analogWrite(kunci, meetAndroid.getInt());
int data = meetAndroid.getInt();
Serial.println(data);
if(data>128 && data<=255){

Serial.println("KUNCI");

digitalWrite(selenoid,LOW);

delay(2000);

}

if(data<128 && data>=0){

Serial.println("buka");

digitalWrite(selenoid,HIGH);

delay(2000);

}

}
voidb_receive(byte flag, byte numOfValues)

{

//  analogWrite(kunci, meetAndroid.getInt());

int data = meetAndroid.getInt();

Serial.println(data);
if(data<128 && data>=0){

Serial.println("alarm off");

digitalWrite(alarm,LOW);
}

}

void setup()

{

Sim900Serial.begin(19200);          

     // the SIM900 baud rate   

meetAndroid.registerFunction(a_receive, 'r');

meetAndroid.registerFunction(b_receive, 'g');

Serial.begin(9600); 
delay(500);

  Sim900_Inti();
SendTextMessageTEST();
}
 //98 D3 31 FB 1E A3

void loop()
{  

deteksi=digitalRead(pin_sensor);

if(deteksi==HIGH){

Serial.println("Sensor getardeteksi");  

alarm_aktiv();

SendTextMessageAlarm();
}
meetAndroid.receive(); 
// you need to keep this in your loop() to receive events

if (Sim900Serial.available())         // if date is comming from softwareserial port(data is comming from gprs shield)

  {

while(Sim900Serial.available())          // reading data into char array 

    {

buffer[count++]=Sim900Serial.read();     // writing data into array

if(count == 64)break;

  }

Serial.write(buffer,count);    // if no data transmission ends, write buffer to hardware serial port

Serial.println("data"); 

Cmd_Read_Act();              //Read the 'COMMAND' sent to SIM900 through SMS

clearBufferArray();              // call clearBufferArray function to clear the storaged data from the array

count = 0;                       // set counter of while loop to zero
  }

//  if (Serial.available())            // if data is available on hardwareserial port ==> data is comming from PC or notebook

//    Sim900Serial.write(Serial.read());       // write it to the GPRS shield
voidclearBufferArray()         // function to clear buffer array

{

Serial.println("CLEAR"); 

for (inti=0; i<count;i++)

{ buffer[i]=NULL;}        // clear all index of array with command NULL

}

void Sim900_Inti(void)

{

Sim900Serial.println("AT+CMGF=1");

delay(500);

Sim900Serial.println("AT+CNMI=2,2");

delay(500);

}

voidCmd_Read_Act(void)  //This function read the SMS sent to SIM900 shield, then act based on the command.

{  

Serial.println("READ"); 

char buffer2[64];

charcomparetext[45];    //take out the first part of the SMS which include the phoneunmber

for (inti=0; i<count;i++)

{ buffer2[i]=char(buffer[i]);}  

memcpy(comparetext,buffer2,45); //take out the first part of the SMS which include the phoneunmber

Serial.println(comparetext);

if (strstr(comparetext,phonenumber))

  {      

if (strstr(buffer2,"Buka"))            //If there are word 'ON' in the SMS, turn on GPIO 1 of SIM900

    {

digitalWrite(selenoid,HIGH);

   //   Sim900Serial.println("AT+SGPIO=0,1,1,1");// set GPIO 1 PIN to 1

SendTextBukaKunci();

 // delay(2000);

    }

if (strstr(buffer2,"Tutup"))        //If there are word 'OFF' in the SMS, turn off GPIO 1 of SIM900

    {
digitalWrite(selenoid,LOW);

SendTextTutupKunci();

 //delay(2000);

 //     Sim900Serial.println("AT+SGPIO=0,1,1,0");// set GPIO 1 PIN to 0

    }

  }

}

voidSendTextBukaKunci()

{

Sim900Serial.print("AT+CMGF=1\r");    //Sending the SMS in text mode

delay(100);

Sim900Serial.println("AT + CMGS = \"+6289503554105\"");//The target phone number

delay(100);

Sim900Serial.println("Perintahditerima, Pintudibuka");//the content of the message

delay(100);

Sim900Serial.println((char)26);//the ASCII code of the ctrl+z is 26

delay(100);

Sim900Serial.println();

}

voidSendTextTutupKunci()

{

Sim900Serial.print("AT+CMGF=1\r");    //Sending the SMS in text mode

delay(100);

Sim900Serial.println("AT + CMGS = \"+6289503554105\"");//The target phone number

delay(100);

Sim900Serial.println("Perintahditerima, Pintudikunci");//the content of the message

delay(100);

Sim900Serial.println((char)26);//the ASCII code of the ctrl+z is 26

delay(100);

Sim900Serial.println();

}

voidSendTextMessageTEST()

{

Sim900Serial.print("AT+CMGF=1\r");    //Sending the SMS in text mode

delay(100);

Sim900Serial.println("AT + CMGS = \"+6289503554105\"");//The target phone number

delay(100);

Sim900Serial.println("READY....");//the content of the message

delay(100);

Sim900Serial.println((char)26);//the ASCII code of the ctrl+z is 26

delay(100);

Sim900Serial.println();

}

voidSendTextMessageAlarm()

{

Sim900Serial.print("AT+CMGF=1\r");    //Sending the SMS in text mode

delay(100);

Sim900Serial.println("AT + CMGS = \"+6289503554105\"");//The target phone number

delay(100);

Sim900Serial.println("ALARM !! PINTU BAHAYA");//the content of the message

delay(100);

Sim900Serial.println((char)26);//the ASCII code of the ctrl+z is 26

delay(100);

Sim900Serial.println();

}

2. AplikasiSitemPengendaliPada Smartphone Android Menggunakan Eclipse

2.1 Program Input.xml SistemKendaliInterfaceUntukSistemKontrol


<?xmlversion="1.0"encoding="utf-8"?>
<LinearLayoutxmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"
android:layout_width="fill_parent"
android:layout_height="fill_parent"

android:background="#ffffff"

>

<EditTextandroid:id="@+id/deviceIDField"



android:layout_width="fill_parent"



android:layout_height="wrap_content"



>

</EditText>

<Button


android:id="@+id/okButton"

android:layout_width="fill_parent"

android:layout_height="wrap_content"

android:text="Set Device ID"
/>
<ImageView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_gravity="center"
android:background="#fff"
android:src="@drawable/logo"/>
</LinearLayout>

2.2 Program Main.xml SistemKendaliInterfaceUntukSistemKontrol

<?xmlversion="1.0"encoding="utf-8"?>
<LinearLayoutxmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"

android:layout_width="fill_parent"

android:layout_height="fill_parent"

android:background="#cdcdcd">

<View

android:id="@+id/ColorIndicator"

android:layout_width="fill_parent"

android:layout_height="0dp"

android:layout_gravity="center"

android:layout_weight="0.20">

</View>

<LinearLayout


android:layout_width="fill_parent"


android:orientation="vertical"


android:gravity="center"


android:layout_height="0dp"


android:layout_weight="2">


<LinearLayout


android:layout_width="fill_parent"


android:layout_height="0dp"


android:layout_weight="0.73"


android:paddingRight="10dp">



<TextView




android:layout_height="wrap_content"




android:text="Pintu"




android:layout_width="fill_parent"




android:layout_weight="4"




android:layout_gravity="center"




android:gravity="center"




android:textColor="#000">



</TextView>



<SeekBar



android:id="@+id/SeekBarRed"



android:layout_width="120dp"



android:layout_height="wrap_content"



android:layout_gravity="center"



android:layout_marginRight="40dp"



android:layout_weight="1"



android:max="255"



android:minHeight="50dp"



android:progressDrawable="@drawable/progress_horizontal"



android:thumb="@drawable/btn_square_overlay_normal"



android:thumbOffset="4px">



</SeekBar>


</LinearLayout>


<LinearLayout


android:layout_width="fill_parent"


android:layout_height="0dp"


android:layout_weight="0.72"


android:paddingRight="10dp">



<TextView




android:layout_height="wrap_content"




android:text="Alarm switch"




android:layout_width="fill_parent"




android:layout_weight="4"




android:gravity="center"




android:layout_gravity="center"




android:textColor="#000">



</TextView>



<SeekBar



android:id="@+id/SeekBarBlue"



android:layout_width="120dp"



android:layout_height="wrap_content"



android:layout_gravity="center"



android:layout_marginRight="40dp"



android:layout_weight="1"



android:max="255"



android:minHeight="50dp"



android:progressDrawable="@drawable/progress_horizontal"



android:thumb="@drawable/btn_square_overlay_normal"



android:thumbOffset="4px">




</SeekBar>


</LinearLayout>

</LinearLayout>
</LinearLayout>
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